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Abstract 
 

Branching stories are challenging to write. We propose an interactive branching editor meant to 

ease their writing process. We interviewed experienced authors in creative story writing and 

studied existing similar tools in order to formulate the editor‟s requirements. The editor‟s design 

was an iterative process mainly focused on its user experience. We implemented a prototype 

interface for testing the final design. The conducted experiments concluded that the prototype is 

useful in organizing, correcting and polishing branching stories, although pen and paper is still 

preferred when first planning the general flow of the story. In the future works section we 

provide some suggestions on how to improve the editor. 
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1. INTRODUCTION 

 

Branching narratives are understood as stories that unfold distinctly depending on the actions or 

decisions made by users (Young, 2006). These narratives introduce some challenges not seen in 

traditional story creation. Their non-linear structures must respond to the user‟s action 

accordingly, ensuring the story reacts properly to the users‟ actions or decisions. This necessary 

response creates a new challenge to the story‟s discourse. Authors are required to plan ahead and 

anticipate user input in order to provide proper answers. 

 

Ultimately, this project‟s target was interactive storytelling authors; professional or experienced 

scriptwriters with a background in creative writing. We wanted to study their writing process and 

understand how it is different than traditional writing. The resulting insight was instrumental in 

providing authors with an approach that eases the complexity of writing interactive stories. Our 

observations lead us to a list of requirements, which was translated into a tool that would 

enhance their writing process.  

 

Our proximity to authors involved in this kind of projects was an encouraging factor for this 

project. Such proximity revealed that writers rarely rely on digital tools to plan their stories. This 

means that our proposal had to have intuitive and accessible interface between authors and their 

stories. But the tool had to ensure that any potential technologies involved don‟t constrain their 

creativity and efficiency. Relying on information technologies, we believed in an integrated tool 

that helps authors in writing their interactive stories, creating and structuring content, oriented to 

user interaction. The output had to be standardized enough to be processed and stored by third 

party systems, increasing the potential connectivity with other information platforms.  
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2. CORE GLOSSARY 

 

This glossary is to define terms that may be ambiguous, or may have other definitions in other 

works. 

● This software/tool/editor/workplace/Branching Story Editor: reference to the 

program/prototype being implemented as part of reaching this project‟s objective. 

● Non-linear: describes something that has one beginning, but can have multiple endings. 

Some stories allow a reader to start reading from one beginning, but let them make 

decisions throughout the book. With these decisions, the path taken will lead them to 

different endings of the story. Essentially the reader becomes an active agent in the story. 

● Branching story: a sequence of states of the story linked non-linearly between them. A 

linear story is experienced from beginning to end. In contrast, one story state may lead to 

one, but also more than one, other states of the story. A series of states can also lead to a 

state visited earlier; this creates a cycle in the story. 

● Branching dialog: similar to a branching story, but only when involving dialogs. The 

states are now lines of dialog between two or more characters. However the non-linearity 

is the same, so it‟s a similar concept to a Branching story. 

● Writer/User/Creator: the user of the program developed. 
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3. INTERVIEWS 

 

Interviews were the first task performed for the project. We felt it was the most efficient way of 

getting information about the creative process, and of identifying potential gaps 

 

The interviews helped in discovering working processes and the technological needs of our 

target demographic. The interviews helped us to dig deeper when a usability/functionality gap 

was detected in the tools, which gave a more detailed description of the gap. 

 

The interviewees were students finishing their degrees related in Audiovisual Communication or 

Interactive Narrativity. The projects are in fact their Projectes de Fi de Grau (TFGs). 

 

However, in both cases the interviewees had new jobs related to their backgrounds at the 

moment. With that experience they often compared how they worked on their projects before 

and how they would work on them now that they had more experience. This made for an 

interesting contrast and richer interviews. 

 

3.1. General questions 

 

The interviews were open, based on the following set of questions. When an interesting topic 

was found, we improvised questions to expand on said topic. 

 

Personal experience - these questions are meant to get information on the interviewee's 

background and create a profile after them, to see how they fit: 

● What is your personal experience in story writing / developing projects that require story? 

● Do you have any technical background, such as programming? 

● What are you working as, currently? 

 

In a workplace - these questions will identify how much a tool is needed, and possibly when it 

could be used in the workflow: 

● How many tools do you normally use for your work? One, many... 

● In the case of scriptwriting, how is normally the workflow in your workplace?  

○ What are the parts you like about it?  

○ What are the parts you‟d change? 

● In your workplace, how much freedom do you have when writing?  

○ What‟s the best creative freedom you have? 

○ And what aspect of creativity could improve? 

● Are dialog trees needed often in your workplace‟s projects? 

● How are dialog trees normally thought up? 

 

On a personal level - these questions may give additional information and suggestions that may 
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help detailing the tool: 

● What would be your ideal workflow when writing? 

● Do you have personal projects that needed dialog trees? 

○ What has been your personal workflow there? 

● What are the difficulties when writing dialog trees? Consistency, keeping the character‟s 

personality? 

 

3.2. Interview #1: project Phenomena 

 

The first meeting was to interview two of the developers of a TFG, Phenomena (del Nido, 

Postigo, Alcalde, Coscujuela, 2012).  

 

Phenomena‟s objective was to design a video game which focused on a developing story and 

player choice. The story and choice would affect the videogame and its gameplay. It was 

reasoned that, at the time, there was little general focus on the narrative of a videogame. 

 

The game designed was an Role-Playing Game (RPG). In RPGs players typically explore a map 

with their characters to find monsters and objectives. Battles with said monsters normally take 

turns for the player‟s team and then one for the enemies‟ team.  

 

Phenomena was fit with a coral roster of characters. Not one character had more relevance than 

the others, but they shared the main role as the story progressed. The game would have an 

overall plot that would be revealed little by little, while the game would be divided into chapters, 

with shorter story arcs. These chapters introduce each character and their backstory. The players 

had to make a moral decision about these characters in the end. The decisions wouldn‟t 

necessarily affect the main story. 

 

The interviewed explained some background about themselves. They graduated on Audiovisual 

Communications at Universitat Pompeu Fabra (UPF). When allowed, they chose subjects closely 

related to interactive storytelling due to interest. Although little technical knowledge was taught 

in these courses, the interviewed possess basic knowledge of ActionScript. 

 

Software tools were used for the creation and documentation of their TFG. But the interviewees 

had already learned how to use these programs, mainly through their degree: 

● Microsoft Word was used mainly for writing scripts and design documentation. 

● Adobe Photoshop was the first option when designing the files structure (which didn‟t 

work well), as well as drawing diagrams for the design. 

● Google Docs at the time was a bad choice when working collectively in a single 

document. It also didn‟t scale well or work well with images. 

● Microsoft PowerPoint was used for the presentation as well as creating some diagrams 

for the files. 
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● Adobe InDesign was the second choice for files designing. It worked correctly. 

 

As mentioned above, the game would have multiple-choice situations, be it simple dialogue or 

moral dilemmas. These choices planned in a general scale; a detailed script was deemed 

unnecessary for the project.  

 

However, writing the general choices was done by a tool whose name the interviewees could not 

recall. They had also used it sometimes in their studies. It allowed to connect dialog bits with 

dialog choices. A decision on these choices would lead to a dialog path different to the one if 

another decision had been chosen. However this flow was not visually clear to distinguish. The 

interviewed also had problems when connecting the dialog bits to the dialog choices, as it was 

hard to do. 

 

The authors spoke about their process for the project as well. All authors of the project defined 

the general storyline in a diagram, which everyone could look at. Afterwards, each author took 

one chapter of the storyline and created it by themselves. Everybody was free use their own 

writing style. Periodically, all authors would meet again to check everyone‟s progress, to 

eventually join every chapter together sequentially. 

 

The biggest problem the interviewed had was a proper way to join bits of information from 

different authors‟ computers (like the story chapters) in a single document. This problem 

sometimes still persisted in the interviewees‟ job space. 

 

In addition, and to expand on their professions, the interviewees‟ were at the time of the 

interview working for a company focused on interactive routes for museums. The objective of 

these routes was to keep the visitor‟s interest while explaining information about the museum‟s 

content. They mainly used Unity to develop these applications. 

 

In their line of work, the problem of joining collective effort in a single file also happened at 

times; particularly, when joining different projects in Unity into one. Only one person could 

work on that, creating a bottleneck in the process. There‟s allegedly a Unity plugin to help join 

the parts, but it was not easy to operate. 

 

Additionally sharing information to all interested workers was also a challenge. Dropbox worked 

correctly for file sharing, but was uncomfortable if many people were using it at once. Making a 

Wiki was proposed, since it was a good system to share and edit information; however it was not 

so good for file sharing. 
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3.3. Interview #2: project Beyond the Woods 

 

 

Fig. 1. Beyond the Woods‟ logo 

 

In the second interview we met the co-author of another TFG related to interactive narrative. The 

project was called Beyond The Woods (de Llorens & Careta, 2013). 

 

Beyond the Woods (BTW) documented the creation of a mega-verse based on seven tales of the 

Grimm Brothers (J. Grimm & W. Grimm, 1812). The mega-verse created by the authors of the 

project is a set of fictional universes, where all the events, characters and places of the tales 

coexist. The player began as one character, the Valiant Little Tailor. They traversed the world, 

making decisions that brought them to another part of the world (depending on the decision). 

With this the user could explore different tales each time, making it effectively a Branching 

Story. It is interesting to note said decisions could be big or small. Some of them included simply 

responding to a question in one way or another, much like a dialog tree. 
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Fig. 2. Beyond the Woods‟ storyline, on a corkboard 

 

The interviewed had always had interest in creating stories, like short stories and short films. 

However it wasn‟t until the beginning of the degree when they acquired interest on interactive 

narratives. The interviewee also graduated on Audiovisual Communications at UPF. Beyond The 

Woods was an idea created bit by bit from different subject projects throughout the degree. Each 

new subject added complexity to BTW. In fact, Beyond the Woods was, originally, a small 

project done for a subject, too. 

 

The interviewed had basic knowledge of ActionScript. They learned ActionScript in the degree, 

but was never a focal point of the studies. The interviewee had interest in knowing about 

technologies and their potential/limitations, so as to use said technologies to their full extent. 

 

The interviewed used a set of tools in the TFG. Initially, the objective was to release a teaser of 

the game. Therefore they used certain tools to make the game prototype behind the teaser, and to 

record/edit video itself: 

● Adobe Photoshop was used mainly to create the games‟ graphics. It suited these 

necessities, but as the project progressed towards a more vector style, this choice was not 

the best. 

● Adobe Flash was used for animating the visual elements of the video. 

● Final cut was used for editing the teaser used for the final presentation. The authors were 
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already proficient with the tool, and thus worked as expected. 

 

One of the biggest challenges when documenting the project was organizing the whole storyline 

in a single diagram. The mega-verse created was big, and every decision would mean a different 

situation for the player. A different number of technologies were tested to cover that need: 

● Adobe Photoshop was the first idea that came to mind; however it is not designed for 

diagram creation and was hard to work with. 

● A software for tablets (name not remembered) was the next application tried, and a new 

one for the authors. The tools could create a diagram as desired. However they could not 

make the size of the diagram‟s canvas grow after a certain size, which was critical given 

the size of the diagram. 

● Trout was the second new software for the interviewees. It was functional and covered 

the necessities of creating diagrams. But the interface design was not intuitive, and hard 

to comprehend. Node icons were customizable among other visual elements; but the 

information diagram nodes could carry was very limited, and often had to use alternative 

techniques to discriminate nodes. One example of that was giving nodes from one Grimm 

tale a different color from the others. It was also hard to scale the project with this 

software. This included each individual element (resizing nodes…) and the whole 

diagram. 

● Finally, the creators decided to plan the diagram with post-its. It gave them a great deal of 

freedom in changing the node‟s physical positions, and adding/removing connections 

between nodes. Though not digital it gave the authors greater freedom than any other 

software they tried. 

● Eventually, they used Adobe Illustrator to translate the diagram into a computer. The 

vector graphics of the program were suitable for making diagrams, if not ideal. 

 

Overall, the interviewed felt like the traditional corkboard with post-its was the best tool to create 

and modify a story diagram. Nevertheless, they did lack a software that could comfortably 

transform what in the corkboard to clean, digital diagram. 

 

The interviewed talked about the general process the project underwent. The creation of the 

script was a unique process; the developers of the project read and chose 7 tales from the Grimm 

Brothers. These tales would be added to the mega-verse, and so to the script. Then, they 

intersected all the coincident elements in these tales (towers, kings, kidnappings, giants…). They 

connected the elements so that every decision made would take the player to a continuation of at 

least one of the original tales; although the endings of their story were different from the original 

stories‟ endings. 

 

Every element from the 7 tales was well organized on spreadsheet. A bottleneck happened when 

intersecting the elements, because there were a lot of them. They had to be careful not to lose 

consistency or generate plot holes in their storyline. 
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The project posed creative challenges as well. Finding the consistency throughout the diagram, 

keeping the player interested while giving them enough decision freedom, and making the game 

fun while replaying it were important concerns for the authors. 

 

The interviewee talked briefly about their job at the time. They were working on video 

production, focused on general announcements and journalism videos. The videos were 

produced in an environment with many editors. The interviewee also had responsibilities in PR. 

Since the videos‟ objectives and ideas were planned before, the creative freedom of the 

interviewee was limited. 

 

3.4. Necessities and ideas for tools 

 

These interviews provided us with software necessities in clearly identified parts of certain 

creative processes. 

● There were at the time few tools that could competently allow collaborative file editing. 

● A good system that allows sharing of information (like Wikis) and also sharing of files 

(like Dropbox). 

● An easier Unity plugin to merge different projects into a single one. 

● A non-linear diagram editor. It should be easy to use and oriented to organizing the flow 

of the story and dialogues. 

● A better way to read the flow of a branching story or dialog (the beginning, the decisions, 

the outcomes). 

 

Interestingly enough, both interviews were arguably about projects with Branching Stories, and 

in both cases there was not a tool that could completely fill the needs the interviewees had. 
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4. RELATED WORKS 

 

The interviews left us a list of necessities extracted from the meetings. We could choose any of 

those necessities and develop a program to help cover the tool gap. From this list of possibilities, 

we decided to develop a program that would help in the last two necessities. That is, a non-linear 

diagram editor, to organize the flow of a branching story or branching dialog. The tool would 

also help reading the flow of the story and document it. 

 

Once we chose the objectives of the software, we studied programs that had been released 

before. These tools offered, at least partially, functionalities with similar objectives to the ones 

we wanted to cover with our tool. We did this to investigate what features had already been 

implemented and also what these programs lacked. 

 

The generic range of analyzable programs was very big; only a couple of tools were studied in 

this project. They were selected thanks to the feedback of the interviews. That is, the interviews 

defined the objective of the tool, and we‟ve researched tools with a similar objective. 

 

We studied the following programs: Aurora Toolset (Bioware, 2002a) , Chat Mapper (Urban 

Brain Studios, 2013) and Articy:draft (Nevigo). 

 

4.1. Aurora Toolset: dialog tree editor 

 

 
Fig. 3. Aurora Toolset‟s dialog user interface 

 

The Aurora Toolset is a software tool normally packaged with the games that are created with it, 

such as Neverwinter Nights (Bioware, 2002b) and Dragon Age: Origins (Bioware Edmonton, 



14 
 

2009). It is designed to create and edit video game levels, playable as a module for the game it 

comes packaged with. 

 

One of the perks of said toolset is to create simple branching dialogs and attach them to certain 

Non-Playable Characters (NPCs) (that you can also create). Every dialog consists of an NPC 

greeting, followed by one or more possible responses to that greeting, then the NPC responds, 

and so on. The conversation ends when the current dialog node has no children. 

 

You can also put conditions on responses to control when they appear on the tree. In addition, 

certain responses can carry a script after they‟re shown; said scripts will perform an action 

relevant to the gameplay. 

 

4.2. Chat Mapper 

 

 

Fig. 4. Chat Mapper‟s user interface 

 

Chat Mapper is a standalone program. It was developed to make intricate dialogue trees and 

export them in some way or another. 

 

The application allows the creation of characters, items and places. The user can also give them 

names, descriptions and purposes, which may or not be used later in the dialog. 

 

The dialogues are put inside conversations. Conversations allow the reader jump from one dialog 

to another, so long as they belong to the same conversation. Inside these conversations, nodes are 

the elements that transmit the sentences. Nodes also can be given an emitter and a receptor of the 
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dialogs. These normally switch places after every node, that is, the receptor becomes the emitter 

and vice versa (like a normal dialog would). Nodes can have only one child. 

 

Groups are the elements that branch the dialog into multiple dialog decisions. Groups can have 

multiple children, who lead to different nodes. 

 

Chat Mapper also uses LUA (a simple scripting language) to set statuses and relationships 

between elements of the conversation. For instance, setStatus(Actors[“Paul”], Items[“Wallet”], 

“found”) means “Paul found Wallet”. These statuses can be used as conditions. Conditions hide 

and show certain paths and conversations at certain moments. 

 

Finally, Chat Mapper provides a simulator for the user to navigate through the dialogs 

comfortably. With this the user can check that the nodes and groups are correctly connected, that 

the conditionals are working properly, etc… The simulator has a group of monitoring windows, 

or trackers (mutual status tracker, variable tracker, possible choices tracker…) to help monitor all 

the mentioned elements accurately. 

 

4.3. Articy:draft: dialog tool 
 

 
Fig. 5. Articy:draft‟s user interface 

 

Articy:draft, as a whole, is a tool oriented for sketching, designing and planning video games, in 

many aspects. This includes character design, basic game logic planning, sketching of stories and 

places, and also dialog creation. 

 

Every dialog is put inside a dialogue object to fit in the general flow of the tool. The dialog 
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objects are mainly made of dialog fragments; these are the basic form of information. The 

fragments contain information such as the emitter, what is said, the emitter emotions at that 

moment, etc. 

 

In order to branch the dialog, Articy:draft uses Hubs. Hubs are elements that let multiple dialog 

fragments be their children, each accessible by a certain decision (a previous fragment) in the 

hub. It should also be noted two decisions can lead to the same dialog fragment in the end. 

 

Finally, the dialog tool also includes jumps. Jumps can be called after any other element of the 

tool. It will make dialog jump from that element to a hub selected previously by the author. 
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5. REQUIREMENTS DOCUMENT 

 

After analyzing the interview results, selecting an objective for our software, and having done 

researching related software, we decided to move forward into developing a tool. Said tool 

should be oriented for experienced scriptwriters and would help them manage branching stories 

and/or branching dialogs in a intuitive and polished way. Users also had to be able to generate an 

output file.  

 

This section deals with translating the needs expressed in the interviews and the analysis of the 

related works into a requirements document. As such, the interviews and related works were 

instrumental in determining the requirements. These requirements are more formally described 

necessities of the tools which will be fundamental for later design decisions. 

 

5.1. Section glossary 

 

● PDF: a type of formatted data storing commonly known for its readability. It can be used 

for documentation. 

● XML/JSON files: these files have data translated in XML/JSON format. These files are 

commonly used for easier storing and loading of data from one application to a different 

one (serialization). 

● Graphs, edges and vertices: terminology borrowed from, and based on, the graph theory 

(Koman, Busby, & Ross, 1987) discipline, and these elements share behavior with said 

discipline. 

 

5.2. Table of requirements 

 

Inter

view 
Observation Requirement/s Req. type 

Impact on 

design 

1 Difficulty to connect one 

dialog piece with 

another is inconvenient. 
 

(In addition, most of the 

related works have 

complex data elements 

that are hard to 

understand: dialog 

fragments, hubs, 

groups…) 

A system to connect pieces of 

story/dialogue simply but 

effectively; for instance, a 

system of graphs (edges + 

vertices). 

Functional, 

static 

Very high 
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1 Inability to check how 

one dialogue option 

would lead to another is 

inconvenient. 

The directionality of the 

dialogs can be set manually for 

each relationship between 

dialogs (for instance, allowing 

and edge to be unidirectional or 

bidirectional). 

Functional, 

static 

High 

2 The interfaces of the 

currently used software 

are saturated and not 

intuitive. 
 

(This also happens in 

most related works since 

they are not centered 

solely on branching 

stories/dialogs creation) 

Intuitive design with few 

elements, even if that means 

less (extra) features 

Functional, 

volatile 

High 

2 Element customization 

lacks in recent 

programs. 

Allowing for some 

customization like icons to 

every node (and colors) is 

good. 

Functional, 

static 

Low 

2 There’s usually not 

enough writable 

information to make 

each element of the story 

unique and 

distinguishable 

 

(Also, elements of the 

related works‟ were 

almost not customizable) 

Make the information writable 

at every element to 

discriminate ample (such as 

characters or places). 

Functional, 

static 

Low 

2 Scaling of the whole 

project is a tough thing 

to find in the current 

software offer. 

Introduce interface and 

functionality mechanisms 

focused on project scalability 

and easy information 

reorganization. 

Functional, 

volatile 

High 

2 Vector graphics help 

making diagrams 

Make the creation of elements 

via simple methods (click, drag 

and drop…) 

Non-

Functional, 

static 

Low 

2 Lack a software that ● Orient the software at ● Functional, Very high 



19 
 

could comfortably 

transform what was 

there to an 

understandable diagram. 

organizing a branching story, 

rather than one to create it 

from scratch 

● Make data exportable to files, 

for either documentation or 

further usage in project 

development. 

static 

● Functional, 

static 

1 & 2 The interviewees at 

times stopped using tools 

because either the 

interface was too 

complex or the steps to 

perform a task were too 

complicated. 

● Creation and removal of 

elements should require the 

smallest amount of steps 

possible. 

● Managing files and projects 

should be easy and intuitive. 

This includes saving, closing, 

opening and changing 

projects. 

● Functional, 

volatile 

● Functional, 

static 

High 

1 & 2 While the processes 

were explained, the 

interviewees talked 

about using programs on 

their tablets as well as on 

their PCs. 

The tool should be cross-

platform (at least PC-tablet). 

Non-

Functional, 

static 

Low 

1 & 2 The interviewees seemed 

to gravitate to simpler 

tools, or tools that didn‟t 

require a powerful 

machine. 

● The tool should load 

relatively quickly. 

● The tool should not need 

high-end computing power.  
 

● Non-

Functional, 

static 

● Non-

Functional, 

static 

High 

Table 1. Table of requirements 
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6. SOFTWARE DESIGN 

 

This section is dedicated to the whole process of designing the software. The objective of this 

section was to create a first design of the software, specially its user interface, and test its 

usability with user experiments. The experiments resulted in possible changes to the interface, 

which were applied accordingly, and new user experiments took place afterwards. Interface 

adjustment was done three times counting the first iteration 

 

To describe this process comfortably, this section is structured with iterations. Each iteration has 

a subsection showing the current design iteration, the changes done to it and images reflecting 

the changes. Afterwards, there will be an experiment of that iteration and their conclusions. 

There‟s a total of three design iterations in this project. 

 

The first iteration was the longest because we had to establish many concepts from the ground 

up. For instance, we had to translate the requirements into design solutions, since it was the only 

feedback that we had at that moment. We also defined the primary elements of the program, and 

we created diagrams to further structure and define many other concepts related to the tool. 

These concepts include the use cases, and the interface contexts (or concerns). In other words, 

much of the content in the first iteration was created for the first time. 

 

6.1. First iteration 
 

a) Table of design solutions 

 

Requirements Design solutions 

A system to connect pieces of story/dialogue 

simply but effectively; for instance, a system 

of graphs (edges + vertices). 

Use graph elements and theory (Koman, 

Busby, & Ross, 1987) to differentiate 

elements and relations (since the discipline is 

widely studied it should be a reliable base of 

design). 

The directionality of the dialogs can be set 

manually for each relationship between 

dialogs (for instance, allowing and edge to be 

unidirectional or bidirectional). 

Apply edge directionality like in graph theory. 

Intuitive design with few elements, even if 

that means less (extra) features. 

Creation of a well-thought user interface with 

basic elements that the user may be familiar 

with. For instance: 

● A menu for file managing and element 

editing. 
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● A toolbar for quickly selecting 

different tools. 

● A canvas where the graphs may be 

edited. 

● Further windows to edit element 

properties. 

Allowing for some customization like icons to 

every node (and colors) is good. 

Each vertex (representing a state of the story) 

should have secondary identifying data: 

● Characters involved. 

● Places it takes place in. 

● Color. 

Make the information writable at every 

element to discriminate ample (such as 

characters or places). 

Vertices can have their various properties 

modified, with data added, removed or 

changed (such as characters); 

Introduce interface and functionality 

mechanisms focused on project scalability and 

easy information reorganization. 

● Any existing vertex can be moved 

around the canvas and be resized. 

● Ease at scaling the project, both the 

whole graph and its elements. 

● Editable canvas should be 

(theoretically) endless, of which the 

user can on only see a part of. 

● Said canvas should be draggable. 

● Said canvas should have a zoom 

mechanism. 

Make the creation of elements via simple 

methods (click, drag and drop…). 

Solvable via interface and interaction design 

in the design iterations. 

Orient the software at organizing a branching 

story, rather than one to create it from scratch. 

Focus iterative filling of data, and make it 

convenient. 

Make data exportable to files, for either 

documentation or further usage in project 

development. 

Exporting to files such as PDF, XML and 

JSON. 

Adding and removal of branching story 

elements have require the smallest amount of 

steps possible. 

Reduction the interface‟s amount of 

submenus, properties‟ windows, or “pop up” 

windows, even if it means less features for 

every tool/option. 

Managing files and projects must be easy and 

intuitive. This includes saving, closing, 

opening and changing projects. 

● The tool must be able to read and save 

files on a local computer; 

● The tool must be able to load images 

from a local computer. 
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● Stories can be created anew, saved as 

files readable by the application, 

closed, and opened; 

The tool must be cross-platform (at least 

between PC and tablet). 

● To this end, the tool should be done 

for browser; 

● The user‟s browser must be expected 

to understand HTML5; 

The tool must load relatively quickly; This heavily would depend on the platform 

and terminal the tool will be used on. HTML5 

may help with loading times. 

The tool must not expect high-end computing 

power. 

Once again, using HTML means the 

opportunity to develop the branching-story 

tool for browsers, which are, generally, 

applications not very needy for resources. 

Table 2. Design solutions 

 

b) Design vulnerabilities 

 

There were a couple of predictions of how the design could change due to requirement 

limitations or design limitations not yet known.  

● The processing or rendering power platform chosen may not be enough. The solution 

should be to either reduce the number of elements rendered/processed, or change the 

platform altogether. 

● The interface may undergo many changes in order to make it more usable and intuitive. 

These changes seemed inevitable. 

 

c) Primary data elements 

 

In this context, data elements could be thought as containers of different kinds of data. In a book, 

data elements could be the Book, which holds all of the story, and the Chapters, which hold a 

series of events that have a strong relation between them. The relation between data elements is 

described with the following image: 
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Fig. 6. Primary data relationships 

 

 

We began by describing the main elements of the tool. We also described what information each 

element could hold, and their visual representation. 

● A Story is a single branching story.  

○ To explain it in more detail, a Story is the container that holds any other kind of 

element inside. These elements should fully describe a branching story/dialog 

from beginning to end, by itself. Technically speaking, a Story and all it contains 

is stored in a single file when saved. 

○ Regarding its visual representation, since it is only a container and has no 

information itself, it is hard to visualize a Story. The canvas could be considered 

the visual representation of a story, because that‟s where the other elements are 

created, edited and removed. 

● A Fragment is a state in the story. A Fragment‟s events could be read from beginning to 

end linearly (no branching). In graph theory, a Fragment is similar to a Vertex. 

○ To go into more detail, Fragments have a name and a description to identify them. 

Descriptions can be long, and can be used to summarize what happens in the 

Fragment. Fragments also have a color associated to them. This is again to 

categorize or differentiate them from other Fragments. 

○ Fragments have a list of Characters and Places associated to them, to further 

classify them. These lists are subsets of the larger storage of Characters and 

Places each story has. 

○ Fragments are visually represented by circles of different colors (specified in their 

properties). The Fragment‟s name is displayed in the center of the circle. The 

Fragment‟s radius is bigger or smaller depending how much is written inside them 
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(length of Name + length of Description). The possible sizes will have a 

minimum and a maximum, so that no Fragment exceeds a certain size. 

● A Relation connects two Fragments together, creating a logical path between them. The 

path is a decision the reader takes. Since the path can be traversed (read) by taking a 

certain decision, it creates a (not necessarily linear) sequence of Fragments. In graph 

discipline, a Relation is similar to an edge.  

○ More can be explained about Relations. Relations have an Action field. It 

describes what action the reader takes to traverse that Relation. Relations also 

have a field named Conditions. They are facts that need to be conceptually true 

for this Relation to be traversed. The tool has do not consider them 

programmatically; rather, it‟s a reminder of conditions that may be implemented 

further down the development of the story. 

○ Relations can be associated to Fragments. A Fragment can be connected with 

many Relations to many Fragments. If that happens, a choice appears. The reader 

can choose only one path. However, if the Relation is bidirectional, the path can 

be traversed in both directions. Choosing a path may mean that some fragments 

may never be reached (through that path). Relations can have their color changed. 

○ Relations are be visually represented by a straight line from the center of a 

Fragment to the other. There will be an arrowhead at one of the line, showing the 

Relations direction. There may be two arrow head if the Relation is bidirectional. 

All these elements can have a changeable color. The Relation‟s action will be 

written over the line. 

● Characters are actors that are important to the story.  

○ To give further detail, each Character has a name, a brief description, and an 

associated image to further describe and discriminate them. 

○ They can be associated to one or more Fragments. While they are not necessary 

for a Fragment to exist, it is an attribute that helps identification of a Fragments. It 

also completes the Fragment‟s content. 

○ They are be visually represented only as their written name in the other elements 

they are associated with. 

● Place are locations where the story eventually takes place. 

○ To give further detail, each Place has a name, a brief description, and an 

associated image to further describe and discriminate them. 

○ They are therefore associated with Fragments. While they are not necessary for a 

Fragment to exist, it is an attribute that helps identification of Fragments. It also 

completes the Fragment‟s content. 

○ They are be visually represented only as their written name in the other elements 

they are associated with. 

● Characters/Places List are two storages of all the Characters/Places in a Story, whether 

said elements are being used or not.  
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○ The Characters List and the Place list will be obviously associated with 

Characters and Places respectively, as they are stored inside them. Also, while 

conceptually a Story and a List are only indirectly related, they are part of the 

same project. 

○ They are be visually represented as a typical list. 

 

d) Diagrams 

 

The use case diagram. Given the design of the tool, the use case diagram doesn‟t really reveal 

any interesting actor interaction. But it‟s rather convenient to pack use cases in different 

themes/contexts and group very similar use cases as one. 

 

 
Fig. 7. Use cases diagram 
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The concerns diagram. The actions a user can do can be grouped up if it makes sense for them to 

be together. These groups can be concerns. Concerns can be similar to interface contexts. Every 

concern has a ultimate objective. Therefore, actions should be grouped into different concerns 

depending on their objectives. Some actions allow to go from one concern to another. 

 
Fig.8. Concerns diagram 
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The sequence diagrams. These diagrams detail the use cases from the use case diagram. We‟ve 

distinguished three parts of the system which interact with one another: 

● The user is the person using the application and that desires to do a certain action with it. 

● The interface. We decided to put the interface as an independent part in the sequences 

diagrams to expand a bit on ideas about how the interface interacts with the rest of the 

system, and when is this system required. 

● The program is the system that does the rest of the administration and operations to run 

the tool. 

All sequence diagrams are in the Annex 11.1. 

 

e) Context wireframes 

 

Below are interface images divided by contexts. Important visual elements are marked with 

numbers and described under each image. 

 

Story edition context 

 

 

Fig. 9. First design iteration Story edition context 

 

1. Canvas (Story). 

2. Fragment. 

3. Relation. 

4. Zoom tools. 

5. Element adding/removal/edition tools, can lead to Fragment edition context and Relation 
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edition context. 

6. File managing menus. 

7. To Character and Places edition context. 

 

Relation Edition context 

 

 

Fig. 10. First design iteration Relation edition context 

 

1. The main context (story) is disabled but visible for orientation. 

2. Destination and origin nodes can be changed. 

3. Bidirectionality. 

4. Color. 

5. Action field. 

6. Conditions field. 

7. The element being edited can be seen selected. 
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Fragment Edition context 

 

 

Fig. 11. First design iteration Fragment edition context 

 

1. Name field 

2. Description field 

3. Color 

4. Characters and Places can be selected from the list to be related to the Fragment being 

edited 

5. Element selected visible in the background 
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Character/Place Edition context 

 

 

Fig. 12. First design iteration Character/Place edition context 

 

1. Type of data the elements below affect (Character or Place). 

2. List of elements already created with buttons to add or delete them. 

3. Selected element‟s name. 

4. Selected element‟s description field. 

5. Selected element‟s image browsing and display. 
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Exporting 

 

 

Fig. 13. First design iteration Exporting edition context 

 

1. Type of file selection buttons. 

 

f) Experiments and results 

 

After the first iteration, we decided to plan a meeting with some individuals knowledgeable in 

user-machine interaction. This gave us expert feedback about the iteration. These volunteers had 

come in contact with the project before, so this feedback iteration is less rigorous than a user-test. 

However it still provided useful suggestions for possible changes. 

 

How the experiments proceeded is described below. 

● The software and its goal were briefly explained: “The tool‟s objective is to easily 

organize a non-linear story (sort of like in a “choose your own adventure” book) and save 

it in your computer”. 

● Subjects were then presented them with the interface contexts. 

○ In this iteration, the interface contexts were displayed as a Flash application. The 

program allowed pressing certain buttons that would transition from one interface 

to the other. The interaction was the one detailed in the design. Users could not do 

other actions such as creating Fragments or Relations. 

● Subjects were asked to do these actions, and describe their process: 

○ Save the Story. 
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○ Create a Fragment. 

○ Remove a Fragment. 

○ Create a Relation. 

○ Edit a Fragment‟s color. 

○ Edit a Relation‟s description, and add a Character to it. 

○ Export the Story to PDF. 

○ Delete a Place. 

● After the subject had attempted to perform these actions, they were briefly interviewed 

about their procedures. Questions depended on how the actions were performed, for 

instance “Was the select icon not clear enough?”, if they did not use the necessary select 

icon; or “Do you think the menu is awkwardly structured?” if they had trouble with the 

menu. 

 

Two volunteers performed the experiment. Below are the conclusions taken from the 

experiments. 

 

Conclusions/observations New solutions 

It is not clear how to use Relation 

directionality. Instead, having two Relations 

with two different directions between the 

same pair of Fragments is much more natural. 

Relations are only one-directional. However, 

there can be two relations for the same pair of 

Fragments, with opposite directions. This 

creates bidirectionality while allowing the 

users to better customize the Relations. 

In addition, Relations will no longer have a 

color. This is done to test its usefulness. 

The way other software organizes their 

menus, even if they include submenus, is 

more intuitive. 

Use two menu buttons with buttons in their 

submenus: 

● File: with New, Open, Save, Save As, 

Close, and Export. 

● Edit: with Edit Selected Fragment 

(available if selected), Edit Selected 

Relation (available if selected), and 

Edit Character and Places. 

There‟s no place where the title of the story / 

name of the file is shown. 

The menu bar now shows the title of the 

Story. 

The toolbar means extra information that 

needs to be learned, and should be used 

● Reduce the toolbar; now it is only used 

to create new Fragments and 
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sparingly. 

In addition, the select button is not intuitive; 

the first reaction is to click on the 

Fragment/Relation directly to edit it. 

Relations. 

● Rethinking of the canvas interaction. 

Now, clicking on objects on the 

canvas will toggle a contextual menu. 

Said menu will contain: 

○ An Edit button that opens the 

edition screen for that element. 

○ A Delete button to remove it. 

○ Pictures of some Characters 

and Places that appear on the 

Fragment, on the left and right 

of the fragment. 

● While selecting a tool, the contextual 

menus won‟t work. 

○ If the “Create Fragment” tool 

is selected, a semi-opaque 

Fragment will follow the 

mouse 

○ If the “Create Relation” tool is 

selected, a small dot will 

follow the mouse. 

A user would spend more time writing, 

modifying, and erasing scripts in the elements 

descriptions. Element edition contexts should 

be given more importance than they have at 

the moment . 

Fragment edition and Relation edition 

contexts increase in size and be restructured. 

It should make edition more comfortable. 

In addition, the Fragment edition screen now 

has search bars for the Character and Places 

list. 

Hard to comprehend how to change the origin 

and destination Fragments of a Relation. 

Fragment lists would grow very big, making it 

unscalable 

Instead of selectable lists, Relation edition 

screens will have buttons that allow to select 

the new Fragment from the canvas. 

Edition of Characters and Places is very 

crowded. Dividing Characters and Places into 

two tabs would help the organization of the 

screen. 

It is not clear how to select a Character/Place 

in order to edit them (should click on its name 

● Creation of two tabs: for Characters 

and Places, and restructure the 

interface elements to give them more 

space. 

● Making the list longer and on a higher 

on the interface, and the attribute 
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on their list). fields lower so as to imply hierarchy, 

● Additionally, adding search bars for 

easier Character/Place finding. 

Table 3. First design iteration experiment conclusions 

 

6.2. Second iteration 

 

This iteration consists of the changes from the first iteration‟s experiment conclusions. 

 

a) Context wireframes 

 

This time, only the changes done since the first iteration are marked in the images. Contexts are 

now subdivided depending on which action is being performed in them. 

 

Story Edition context: 

 

When idle: 

 

 

Fig. 14. Second design iteration idle Story edition context 

 

1. Only two buttons in the main menu: File and Edit. 

2. The Story (file) title on the menu bar. 

3. Toolbar reduced to Add Fragment and Add Relation buttons.  
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When selecting a Fragment: 

 

 

Fig. 15. Second design iteration Fragment selecting Story edition context 

 

1. Contextual menu appears when an element is clicked on once. 

2. Images of Characters that appear on the selected Fragment. 

3. Images of Places that appear on the selected Fragment. 

 

When selecting a Relation: 
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Fig. 16. Second design iteration Relation selecting Story edition context 

 

1. Edit and Delete buttons that will perform these actions on the selected element. Always 

appear on a contextual menu. 

2. Contextual menu appears when an element is clicked on once. 

 

When opening the File menu: 

 

 

Fig. 17. Second design iteration opening File menu Story edition context 

 

1. File submenu with file managing buttons. 
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When opening the Edit menu 

 

 

Fig. 18. Second design iteration opening Edit menu Story edition context 

 

1. Edit submenu with element managing buttons. 

 

  



39 
 

Relation Edition 

 

 

Fig. 19. Second design iteration Relation edition context 

 

1. Names of origin and destination Fragment names. 

2. Clicking these buttons re-enable the Story context. When a Fragment is clicked on this 

way, it will be selected as the new origin/destination fragment. The Relation context will 

reappear. 
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Fragment Edition 

 

 
Fig. 20. Second design iteration Fragment edition context 

 

1. General restructuring / resizing of the context. It is now about two thirds of the screen 

wide. 

2. Characters and Places can be searched by name in their search bars. 
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Character/Place Edition 

 

 

Fig. 21. Second design iteration Character/Place edition context 

 

1. Two clickable tabs now separate the Characters list and the Places list. 

2. Character and Place context are now bigger and restructured. Both resemble each other, 

except for their content and the tab selected at the time. 

3. Characters and places can have their name searched via their search bars. 

 

Exporting 

 

 

Fig. 22. Second design iteration Exporting edition context 

 

1. Window close button. 
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b) Experiments and results 

 

Two test subjects were be asked to interact with the interface, attempting to perform a set of 

actions 

 

Subjects didn‟t necessarily fit in the tool‟s objective demography. This restriction is lifted 

because these experiments were performed to test and refine the user interface, not to determine 

the tool‟s overall usefulness. However subjects had basic level experience with computers and 

related technology. They also had used some sort of graphical editor prior to these experiments. 

 

The interface subjects interacted with was given as a paper prototype, which would contemplate 

every interface done so far. Paper prototyping was described by Snyder (2003) as: 

[...] a variation of usability testing where representative users perform realistic tasks by 

interacting with a paper version of the interface that is manipulated by a person „playing 

computer,‟ who doesn‟t explain how the interface is intended to work. (p. 4) 

 

The experiments proceeded as described below. 

● Subjects were given a brief introduction to the tool. The introduction described the 

elements of the tool and their use. However it did not influence or help the subjects on 

using the user interface. The introduction given was similar to the one below. 

In a “choose your own adventure” book, the tale told isn’t read from 

beginning to end. The reader is asked to make a decision from time to time, and 

each decision result in a different story. This tool aims to organize one of those 

non-linear stories.  

A Story is saved in a computer file, and contains all the elements necessary to 

tell a complete story. 

You can create Fragments, or pieces of the story that can be fully read 

without having to take any decision. They can be given a name and description to 

know what they talk about, and a color to visually identify them. You can also 

relate a Fragment with Characters that may be in them, and Places where the 

Fragment may be taking part in. 

These Fragments can be joined with a Relation, an action that the reader can 

take in one fragment that will lead to the other. You can describe the action to 

perform, and write if there’s any condition to resolve before you can do that 

action. After you’ve created the Relation, you can also change the starting and 

ending Fragments if necessary. 

Characters and Places are data that is also stored in the story. They contain a 

name, a description and an image of a Character and Place that may appear in 

one or more Fragments. As such they can be referenced when editing Fragments.  
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● The tasks the users were asked to attempt. They involved interacting with the interface, 

without giving them any help. During this phase, quantitative results were expected:  

○ The number of clicks per action. 

○ The time taken to perform the task. 

○ The time used for thinking about the next step. 

○ And where the user clicked;  

Less quantitative results were also expected. What routes the user took (if there were 

more than one valid route), and where did they get lost.  

The tasks were as follows: 

 

Task Ideal number of clicks 

Create a new Fragment. 2 

Give that Fragment a new name and 

description. 

6 

Add a Character to the former 

fragment. 

5 

Change a relation‟s destination 

Fragment. 

4 

Save the story. 2 

Create a new Place, add a name, 

description and image to it. 

9 

Export the Story to XML. 3 

Tell me the name of the Story. 0 

Table 4. Second design iteration experiment ideal number of clicks per task 

 

 

● The follow up interviews were placed after the users attempted all the given tasks. This 

interview looked for more qualitative results. Most questions for the interview depended 

on every subject‟s actions. However, general questions were also asked to guide the 

interview: 

○ Were the File and Edit menus intuitive to navigate? 

○ Was the use of the toolbar clear? What about its buttons? 

○ Was it intuitive to click on the Fragments and Relations in order to edit and delete 

them? 

○ Could you change the Fragments of a Relation easily? 

○ Was the name of the Story well in sight? 
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First User 

 

The first subject had no particular experience in story making. Although they were familiar with 

computers and computer applications, they had hardly ever used editing programs either (such as 

Word or Photoshop). The results were: 

 

Task Clicks Time Detours Success 

Create a new 

Fragment. 

4 29 seconds. Additionally, the 

subject 

knowingly saved 

the project, thus 

completing the 

saving task as 

well. 

Unsuccessful. Attempted to 

create a new Fragment 

through File > New 

Give that 

Fragment a new 

name and 

description. 

6 74 seconds. Additionally, 

added a character 

to the fragment, 

completing two 

tasks at once 

Unsuccessful. Attempted to 

edit the Fragment before 

selecting it first. Did not use 

the close button in the 

Fragment Edition screen. 

Change a 

relation‟s 

destination 

Fragment. 

5 42 seconds. Opened the 

Fragment Edition 

first of the 

original 

destination 

Fragment of the 

Relation. 

Unsuccessful. Used the 

Relation Creation tool as if it 

was used to edit Relations. 

Never clicked the Relation. 

Create a new 

Place, add a 

name, 

description and 

image to it. 

7 2 minutes, 

12 seconds. 

Additionally, the 

test subject added 

a description to 

the place. 

Unsuccessful. User did not 

change to the Place tab. The 

user also went straight into 

filling the information, and 

clicked apply, without looking 

at the list on the left. 

Export the Story 

to XML. 

2 34 seconds. None. Unsuccessful. User attempted 

to save via File > Save As. 
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Tell me the name 

of the Story. 

0 23 seconds. None. Unsuccessful. 

Table 5. Second design iteration experiment first user‟s results 

 

 

 

Second User 

 

The second user also didn‟t have a creative profile. He was proficient at computer handling and 

had experience with editing software (such as GIMP or Open Office), although he didn‟t use 

them regularly. Tasks results are:  

 

Task Clicks Time Detours Success 

Create a new 

Fragment. 

1 7 seconds. None. Successful. User used the 

add tool. 

Give that 

Fragment a new 

name and 

description. 

5 27 seconds. None. Successful, although the 

user did not close the 

Fragment Edition screen 

after he was done. 

Add a Character 

to the former 

fragment. 

5 21 seconds. Additionally, the 

user used the 

Character Search 

bar. 

Successful, although the 

user did not close the 

Fragment Edition screen 

after he was done. 

Change a 

relation‟s 

destination 

Fragment. 

4 22 seconds. None.  Unsuccessful. User used 

the Relation creation tool 

as a Relation edition tool, 

did not think of clicking on 

the Relation. 

Save the story. 2 6 seconds. None. Successful. 

Create a new 

Place, add a 

name, 

description and 

image to it. 

7 34 seconds. Additionally the user 

added a description. 

Unsuccessful. The user 

changed the tab but did not 

use the list until after they 

were done. They used the 

apply button as if it were a 

“New Place” button. 

Export the Story 

to XML. 

3 7 seconds. None. Successful 
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Tell me the name 

of the Story 

0 2 seconds. None. Successful. 

Table 6. Second design iteration experiment second user‟s results 

 

These results suggested that the interface was still not intuitive enough. While the tasks were 

completed relatively quickly, there were still obstacles in performance. These detours could also 

be attributed to learning how to use the tool for the first time. While it seems all graphical 

elements are in place, they are not clear enough to those unaccustomed to them. 

 

The complete observations gathered from the follow up interviews are in Annex 11.2. Both the 

interviews and the detours/results mentioned above helped create the following table. This table 

was the base for the final interface design iteration. It describes the more interesting observations 

from the experiments, and changes that could be done to remedy the issues. 

 

Conclusions/Observations Changes 

The toolbar‟s tool icons lack information to 

know exactly what they do. 

● Add a plus sign to the tool images that 

are used to create. 

● Add hover text to the tool buttons. 

Joining the Save As button with the Export 

button is conceptually sensible. 

● The Save As button can save as a file 

readable by the application and also 

export to other files. 

● Put the file extension on the Story 

name to let users know what they are 

editing. 

Enlarging the tabs in Characters and Places 

would help in noticing in which tab the user 

currently is. 

● Allow a bigger tab size. 

The first thing seen in a Character/Place 

Edition Tab are the blank fields, and are 

associated with a form to be filled and that 

can directly create a Character/Place. 

● If no Character or Place is selected, 

filling the attribute fields then clicking 

the apply button should create a new 

Character or Place. 

● If no Character or Place is selected, the 

Apply button should read “Create”. 

The Edit submenu button Edit Characters & 

Places could be divided in two. 

● Remove the Edit Characters & Places 

button from the Edit submenu. 

● Instead, add two buttons Edit 

Characters and Edit Places. 

Save buttons are expected to close the screen ● The typical button names are now 
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once clicked. Accept, which will save and close, and 

Cancel, which will discard changes 

and close the window. 

The name of the story could be in a more 

intuitive spot. 

● Add another bar below the menu bar 

exclusively for the file name (instead 

of the Story name). 

Have more space to click while referencing a 

Character or Place in a Fragment. 

● Clicking the name of a Character or 

Place also references them in a 

Fragment. 

There‟s no sure method to edit a Relation. ● While hovering over a Fragment or a 

Relation, the surrounding area will 

glow to indicate it can be clicked. 

If you close the Relation Edition window 

when changing a node, you may get 

disoriented as to what Relation you were 

editing. 

● When changing the origin or 

destination Fragment to not close the 

Relation Edition window. 

The word “Description” in a field suggests 

using less detail; the word “Content” suggests 

writing more in it. 

● Use the word Content for the 

Fragment description fields. 

Table 7. Second design iteration conclusions 
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6.3. Third iteration 
 

This was the design used on the prototype for the final experiments. A handful of suggestions 

from the earlier interface tests have been taken, as were or modified, and applied to the interface. 

However some of the changes are not visible until interaction is created via a prototype.  

 

a) Context wireframes 

 

Story Edition context 

 

Idle:  

 

 
Fig. 23. Third design iteration Story edition context 

 

1. Story (file) name has its own display bar. 

2. Plus sign on the tool buttons to indicate the Add elements. Clicked buttons change 

background color to a darker color. 
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With the menus open: 

 

 
Fig. 24. Third design iteration Story edition context with open menus 

 

Fragment Edition context 

 

 
Fig. 25. Third design iteration Fragment edition context 

 

1. Buttons text changed. 
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Relation Edition context: 

 

 
Fig. 26. Third design iteration Relation edition context 

 

1. Buttons text changed. 

 

Characters/Places Edition context: 

 

 
Fig. 27. Third design iteration Characters/Places edition context 

 

Button displays “Create” text if all fields are empty. When filled, clicking the button creates a 

new Character or Place. When an element is already clicked, button text changes to “Apply” and 

will apply any changes to the selected element.  
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7. PROTOTYPE USER EXPERIMENT 
 

This experiment was a more formal method of gathering feedback, both in methodology and in 

demography selected. Specifically, these experiments measured results more thoroughly. The 

volunteers also fit the profile of the tool‟s target demography.  

 

While this could be considered the user experiments for the third iteration of design, it is 

different on a few accounts. For one, the testing was done in an actual software prototype. But 

most importantly, these experiments not only helped suggest improvements for the tool. They 

were also used to evaluate the tool‟s overall usefulness. These results help reach the project‟s 

conclusions. 

 

The objectives of the test were: 

● To measure quantitatively the accessibility of creating and translating a story, from a text 

describing a situation to a Story from the Branching Story Creator. 

● To measure quantitatively the usability of the whole tool. Specifically, to test what parts 

of the interface are the less straightforward and could be improved. 

● To measure qualitatively the testers‟ opinions, observations and advice. 

 

Further iterations are possible outside the scope of this project.  

 

In this section, tester is the name given to the individual performing the experiment; and monitor 

is the individual giving out the materials and monitoring the tester. Monitors also perform the 

follow up interviews. Monitors do not necessarily evaluate anything during or after the test. 

 

7.1. Prototype description and restrictions 
 

The prototype was developed in JavaScript (JS), making full use of HTML5‟s canvas feature. 

This was done because interfaces in HTML5 are quick to create and modify, so it is appropriate 

for interface prototyping. 

 

The prototype followed a Model View Controller (MVC) design. The Model where all the data 

elements of the application: Character, Fragment, Place, Relation, and Story. The Controller 

managed all the logic behind it, used the Model, and sent drawing signals and data to the View. 

The view was the conjunction of HTML and HTML5‟s canvas. All these elements were written 

in separate script files. 

 

A few JS libraries were used in the implementation: jQuery (jQuery Foundation, 2014) for 

general help in coding; jCanvas (Evans, 2014) to help in using the visual element canvas; and 

JSColor (Ovdarko, 2013), to easily create a color picker for the Fragments.  
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Two kinds of restrictions were present on these experiments: demographic and technological. 

 

The demographic restrictions were done so as to achieve the target profile of the tool. Testers 

had some experience of writing stories of their own, and understood non-linear type stories. 

Example of ideal test users were: 

● Graduates of creative sciences (such as audiovisual communication). 

● Professional writers or scriptwriters. 

● Anyone who‟s worked closely in developing branching stories (such as game 

developers). 

 

The technological restrictions were features that could not be implemented due to time 

constraints. However we assured they were not critical for the experiment. 

● Zoom buttons were not enabled or shown. 

● Basic file functions (New, Open, Save and Save as) were not enabled. 

● Automatic Fragment resizing depending on its contents was not enabled. 

● Tool buttons had no hover text. 

● Hovering over a clickable element (Fragment or Relation) does not make them glow to 

indicate they can be clicked. 

 

7.2. Methodology 
 

We developed a prototype following both the interface design and software design guidelines 

from the previous iterations. 

 

We used a specific methodology for the experiment, divided in different sections: 

● The monitor briefly explained the first task to the tester, as well as the materials at their 

disposal. 

We will give you a short text that describes a fictional story. The text 

describes a certain state in this story. We ask you that you read it as thoroughly 

as you need. There is no time limit. 

● The monitor then handed the text to the tester. The text describes the protagonist, their 

objective and their surroundings without progressing through time. Nothing happens in 

the text, it is only a description of a situation. The text can be found in Annex 11.3. 

● Once the tester finished reading the text, a computer with the Branching Story Editor 

prototype will be given to them. The monitor then introduced the tool and explained the 

following task. 

“Now you are presented with a program. It helps translate a story with 

many choices from a linear text to a more graphic representation.”  

● The monitor then briefly explained the elements of the software to them (Fragments, 

Relations, Characters, Places), what their use was and how they were represented. An 

example of a branching story was shown to users who needed further explanation. 
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“We ask you that you imagine how the story may develop from the 

situation in the text you were given. It is encouraged that you try to write a story 

with many possible endings, where a situation can have different outcomes. You 

can twist the plot as you wish, and base it on the initial text as tightly/loosely as 

you want. The first Fragment however should describe what is described in the 

text. 

You can ask questions about the interface if you’re stuck. You can use pen 

and paper to help you. However it is encouraged that you use the program as 

your main tool. You can always check the text. Please tell us when you finish. 

There is no time limit.” 

■ Although questions could be asked about the interface, no introduction to 

the user interface was given beforehand. 

● At that point the testers were left to create and organize the Story with the help of the 

software prototype. 

● When the tester finished this task, the monitor collected all the materials, and saved the 

Story. 

● Afterwards, there were brief interviews to gather the tester‟s thoughts. Most questions 

depended on the tester‟s performance and their interaction with the interface. This means 

the questions were thought up on the spot and not written before the experiment. The 

following questions serve as guideline for the questions asked: 

○ Did you struggle with this certain element of the interface? 

○ Could you tell me why did you use that element to do that certain action? 

○ Do you think this tool could replace story creation in pen and paper? 

○ Do you feel this tool could be useful to organize the story once created? 

● Once the interview finished, the monitor thanked the tester for their cooperation, and the 

experiment concluded. 

 

7.3. Measurements 
 

One of the measures was the time taken to perform the overall test and individual tasks. It is a 

more quantitative measurement. It helped determine the efficiency of interface elements and 

what general obstacles were in the creating process. Individual tasks were divided like so: 

● Time of reading the source material. While it was not relevant data by itself, it was 

interesting to measure this task to see if the tester struggles with the comprehension, in 

case it affects the rest of the test. 

● Time to understand the GUI, where the tester explored and learned to use the tool. This 

time stopped being counted once the tester started developing the story comfortably and 

was used to almost all of the interface elements. 

● Time of creating new elements (Fragments, Relations, Characters and Places). In the case 

of Fragments and Relations, we merely counted the time to place them on the canvas; so 
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the times are expected to be small. 

● Time of editing elements (Fragments, Relations, Characters and Places). 

 

The characteristics of the resulting diagram were also measured. While this is a more qualitative 

measurement, it is still important since every experiment can yield different Stories. Spelling 

mistakes or such were not relevant for the present study, rather, the semantics were the important 

factor. The detailed measurements were: 

● The number of elements created. These include Fragments, Relations, Characters and 

places. More elements mean more time required to create a Story.. 

● The element word count. That is the name and content for the fragments, the action and 

condition for the Relations, and the name and description for the Characters and Places. 

More words also mean more required time. 

 

Finally, the tester‟s observations on the experience were the more qualitative results of the 

experiment. It was important to see repeating or similar observations across the experiments, as 

well as observations that were interesting by themselves. 

 

7.4. Results 
 

A total of 3 experiments were successfully performed with three different subjects. This section 

shows the results of the measurements mentioned above. Each experiment is labeled with a 

number #1, #2 and #3. 

 

First of all, this table describes the time measurements. Both task times and overall times are 

included. There is a more detailed table which describes the moments when each task was being 

performed for each tester. The table is at Annex 11.4. 

 

Expe

rime

nt  

Readi

ng 

text 

(seco

nds) 

Lear

ning 

GUI 

(s) 

Creat

ing 

Frag

ment

s 

(s) 

Creat

ing 

Relat

ions 

(s) 

Creat

ing 

Char

acter

s 

(s) 

Creat

ing 

Place

s 

(s) 

Editi

ng 

Frag

ment

s 

(s) 

Editi

ng 

Relat

ions 

(s) 

Editi

ng 

Char

acter

s 

(s) 

Editi

ng 

Place

s 

(s) 

Total 

(s) 

#1 225 91 16 76 139 128 775 88 0 0 1611 

#2 58 164 25 32 0* 0* 575 83 0 0 991 

#3 128 100 70 49 0* 0* 1133 257 0 0 1997 

Table 8. Prototype experiments time measurements 

 

Next, this table shows the element count and word count measurements. They are divided by 
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element. 

 

Experi

ment  

Fragme

nts 

Fragme

nts 

word 

count 

Relatio

ns 

Relatio

ns word 

count 

Charact

ers 

Charact

er word 

count 

Places Place 

word 

count 

#1 9 280 10 42 4 88  2 28 

#2 8 139 7 2** 0* 0* 0* 0* 

#3 15 588 14 131 0* 0* 0* 0* 

Table 9. Prototype experiments element and word count 

*Testers never discovered the expected context that creates Characters and Places. 

**The tester left some Relation‟s Action fields empty on purpose, as they explained in the follow 

up interview. It is not an indication they did not understand how Relations work. 

 

We drew some observations from these results. 

● Testers understood the use of Fragments, which are the main containers of information. 

Fragments contain significantly more information than other elements. This was reflected 

by the longer times spent editing (writing on) them. 

● Characters and Places‟ information is filled when first created, and not edited further 

afterwards. However this observation could be biased due the short length of the 

experiments. These elements seem to be used mostly for “tagging” (complementing) 

Fragments and Relations. This is later discussed on the tester‟s observations. 

● The GUI was explored mostly in the first minutes of the experiment, and occasionally 

afterwards. The learning time seems relatively quick, although we believe it could be 

less. 

● Information put in Relations is scarce, and is rarely changed after they‟re first edited. 

They are treated as simple, shortly described decisions. 

● The conditions‟ field is never understood nor used. In one instance, a tester needed to do 

a different but almost identical sub-story, different in only one aspect, they copied it 

entirely instead of using the conditions. 

 

Finally, we‟ve made a list of the most interesting observations made by the testers on their 

follow up interviews. They are divided in observations most repeated across experiments, and 

observations we found more interesting. 

 

All of the notes and observations extracted from the follow up interviews can be found at Annex 

11.5, divided by each experiment. 

 

First, the most repeated observations: 
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● Testers understood the visual elements with little information given. 

● Testers preferred planning the first steps of a story in pen and paper. It was quicker for 

them to plan the general plot that way. However, the tool was still useful for organizing 

the story and writing it on a computer. More importantly, changes and corrections on the 

story are considered easier to do with the help of our application. 

● “Tagging” Fragments with Characters and Places was useful to describe and identify 

them. 

● It was suggested Characters and Places should also have tags of their own, to further 

classify the elements. 

● Creating and editing Fragments and relations are the most repeated tasks when creating 

Stories. They were considered easy tasks to perform. However, because these tasks are 

repetitive and done many times, it would be convenient to simplify these processes 

further. 

● The Conditions of a Relation were never used. Instead, if a part of the story was identical 

to another, just one condition different, it was be duplicated and slightly edited. 

● Double clicking on elements was the common way to edit them. 

 

Next, the observations we found most interesting: 

● Most of the subjects referred to Relations as Actions, and some refer to the Fragments as 

Nodes. 

● The contextual menu that appear when an element is selected were useful, but weren‟t 

easily found. 

● It was hard for the testers to understand that the canvas could be dragged around. 

● Some testers saw the Characters and Places search bars in the Fragment edition context. 

However, many testers thought they could write names in these bars to create and 

associate Characters and Places to that Fragment. 

● On the other hand, when the Characters and Places editor context was used, it was used 

successfully. 

● The tester‟s first attempt to create a Relation is to drag from one Fragment to another. 

● One tester suggested to be able to customize Relations: different arrowhead shapes, 

different font sizes and different line styles. 

● A Relation‟s data could also be changed so that there‟s a Name field to appear on the 

canvas, and a Content field which is more extensive (akin to the Fragment structure), 

removing the Condition field altogether. 

● Most testers suggested having two palettes when choosing a Fragment‟s color. The first 

one, which is already there, allows to choose from a bigger variety of colors. The second 

palette would only have a few colors. This second palette would help the aesthetics by 

allowing more than one Fragment to have the exact same color. 

● A tester suggested Fragments could be further customized with different shapes (triangle, 

rectangle, star...). 

● Add buttons were not always clicked; they were sometimes dragged to the canvas 
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physically. Testers expected that to create a new element in the canvas (dragging the Add 

Fragment button expecting a new Fragment to be dragged in…). 
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8. CONCLUSIONS 
 

● The first iteration of creating a story will almost always be done in pen and paper. It is 

very easy to use and gives a lot of freedom to the creator. The tool should aim to help 

write a story after that first, more general iteration. 

● Overall, users were very interested in the tool and suggested many corrections and 

improvements. It seems ultimately the tool covers a specific need that no software so far 

covers. While we concluded from the related works that many tools can be used to create 

a branching story, none are focused on it. That the objective of our tool was primarily that 

one seems to favor our tool over the others. 

● Using graph theory to define Fragments and Relations was a good choice. Graph 

visualization is easily understood by most users. Perhaps the users are used to creating 

(not so rigorous) simple diagrams. 

● Users also quickly understood what type of data was contained in each element. This 

could be attributed only to the quick introduction to the elements given at the beginning 

of the experiments. However we believe repetitive use of these elements also helps 

develop fluency in their use. 

● The users who never created Characters or Places with the expected context tried to 

create them with the Fragments‟ search bars. We think once a user believes they‟ve 

discovered one way to complete a task, they won‟t look for another way. 

● The Conditions of a Relation were never used. Users are more prone to have two almost 

identical sub stories with a small difference between them. The condition concept is more 

computer oriented than human oriented. A study should take place to determine if 

duplicating pieces of story is a more comfortable way for user to add conditions. If it‟s 

determined to be an ineffective feature, further experiments could be done to find the 

more intuitive way to add conditions. 

● Users didn‟t give too much detail about Characters or Places. This may be biased because 

most of them did not find the context where they could describe those elements. However 

most users have described Characters and Places as “tags” for the Fragments. Perhaps the 

importance of these elements should be studied, to see if there should have less 

importance, keep the same relevance or reorganize the elements interface altogether. 

● Users have grown accustomed to certain interaction conventions. These customs were 

mostly picked up from other programs. For instance, dragging from one Fragment to 

another to create a Relation, or double-clicking elements to edit them. These conventions 

should be followed to reward the users‟ intuition. 

● Users are fond of classifying elements visually. They suggested many improvements such 

as a more restrictive color palette for the Fragments, or different arrowheads for the 

Relations. 
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● Users don‟t necessarily name the elements like we do. They usually name them after 

similar elements seen from other software tools. For instance, Relations are usually called 

actions, and sometimes Fragments are called Nodes. 

● At some point, some users tried to drag the physical button into the canvas, expecting the 

dragged element to appear there, but that didn‟t work. We should study if the buttons 

could be draggable or if they should keep the current functionality. 
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9. FUTURE WORKS 
 

Most suggestions were derived from the conclusions: 

● Users should be able to select multiple elements at once, to either copy or delete them all. 

This would be coupled with copy/cut/paste features for the elements. With this the 

Conditions field could be eliminated from the software. A study should also take place to 

determine the effectiveness of the feature. 

● Double clicking elements should open their edit context. Relations should be created by 

dragging and dropping from one Fragment to another. Right clicking on an element 

should display a menu with more options about the element. This is done to follow 

interaction conventions. 

● Further experimentation should be done to determine the importance of Characters and 

Places in the interface. This study should explain whether these elements should be 

reduced to “tags”, keep their importance, or redesign their role in the interface altogether. 

● Elements should be more visually customizable. Different shapes for Fragments, different 

shapes and styles for Relations and their arrowheads, more color palettes for the 

Fragments. 

● Actively changing the elements‟ names as the naming convention changes. 

● Study to define the how the users want to work the Add buttons. This is because some 

users tried to drag the buttons onto the canvas. Maybe the button‟s functionality could be 

changed, but maybe it should be kept as it currently is. 

 

Some suggestions are improvements we thought independently. 

● Creating a small “simulator” which allows the user to “play” the story they‟ve done. This 

would help test that the relations are correct, and that their story is coherent. 

● Opening central servers, which would allow multiple people to edit the same file at the 

same time. Interviewees sometimes claimed there‟s a bottleneck when joining different 

small projects together. Servers would help with the problem. Also it seems logical to add 

multi-tasking, because the whole objective of the editor is to make branching storytelling. 

Every writer could write a single part of the story while the others do theirs. There should 

also be an option to either work locally with the tool or on a server. 
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11. ANNEXES 
 

11.1. Sequence diagrams 
 

 
 

Fig. 28. Add Fragment sequence diagram 

 

 

Fig. 29. Add Relation sequence diagram 
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Fig. 30. Change Fragment properties sequence diagram 

 

 

Fig. 31. Exporting sequence diagram 
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Fig. 32. Create new Story sequence diagram 

 

 

Fig. 33. Remove Fragment sequence diagram 
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Fig. 34. Remove Relation sequence diagram 

 

 

Fig. 35. Open Story sequence diagram 
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Fig. 36. Save existing Story sequence diagram 

 

Fig. 37. Save new Story sequence diagram 
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Fig. 38. Create Character/Place sequence diagram 

 

Fig. 39. Remove Character/Place sequence diagram 
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Fig. 40. Change property of Character/Place sequence diagram 

 

 

11.2. Second iteration experiments, interviews 
 

Interview from test #1: 

 

The subject was asked questions both after every task (relevant to the task) and in the follow up 

interview. Questions were divided by topic: 

 

● About the menu bar: 

○ Two buttons “New Fragment” and “New Relation” in the File menu would help 

in creating new elements. Additionally, the tools are not too noticeable or 

understandable. Adding text to describe them would help this issue. 

○ The File menu and Edit menu are familiar, since many applications have this 

format. 

○ Save As button is associated with exporting. Joining both buttons into one would 

be logical and familiar, since other well-known software use that concept. 

● Contextual menus were intuitive and understandable. But it was hard to notice that 

relations could also activate contextual menus. 

● While editing Characters and Places: 

○ The tab system was understandable, but the tabs themselves should be bigger to 

notice them more easily. 
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○ The apply button was associated by saving and adding the character currently 

being worked on. 

○ A valid option to force the character to focus on the list first is do disable the 

attribute fields. 

● The place where the name of the Story was not clear. A bar below the menu bar solely for 

the title of the Story would resolve the issue. 

● Some tasks could be completed through two different paths. For instance, selecting the 

Fragment and clicking Edit > Edit selected Fragment, or clicking the Fragment and 

clicking Edit on the contextual menu. This was not seen as redundant or confusing. On 

the contrary, the subject thought it was a comfortable idea, good for the users that already 

had experience with the software. 

 

Interview from test #2: 

 

The first test individual expressed a list of commentaries while asked the follow up questions, in 

addition to being asked questions after every task (related to the task at hand). The conclusions 

were somewhat richer as we contrasted opinions and suggestions the first test user gave earlier. 

Questions were also divided by topic: 

 

● Commentaries related to the menu bar: 

○ Having an Edit Fragment button in the edit submenu was understandable, even if 

it was not the first thought of the testing individual. 

○ Joining the buttons Save As and Export in the file submenu could make more 

sense.  

● When editing Fragments: 

○ While adding Characters or Places to a Fragment, clicking on the name should 

also reference that piece of data. Buttons “Add all” and “Take all out” would be 

interesting additions as well. 

○ The Create Relation tool should also act as an Edit Relation button. 

○ Menus with menus similar to other programs were recommended to keep their 

structure. However the Edit menu‟s buttons weren‟t very understandable. In 

addition Fragments or Relations can be edited with contextual menus. The user 

wondered whether it was useful to be able to edit those elements from the Edit 

menu. 

● When editing Relations: 

○ When changing an origin or destination Fragment of a Relation, the Relation 

Edition screen shouldn‟t close. This would help the author not lose track of what 

they‟re editing. 

○ The user clicked on the Create Relation button because he wasn‟t sure he could 

click on the relation. They suggested making the area around a Relation 

illuminate while hovering on it with the mouse. This feature would help when 
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learning the tool 

● Some comments regarding the creation and edition of Characters and Places: 

○ While the fields are blank and no Character/Place is selected, user thought they 

could create a new Character/Place by filling the fields. 

○ Disabling the fields so that the user focuses on the list on the left could work. But 

doing so would make the process clunky and slow. 

○ The tab system is intuitive, although enlarging them slightly could help to see 

them better. 

○ In the Edit submenu, two buttons could be placed instead of one: “Edit 

Characters” and “Edit Places”. Each would redirect the user to each tab. 

● Creating another bar for the Story (file) name was considered a good way to make the 

title stand out. However, putting the Story name as the title of the browser tab as well was 

strongly suggested. 

● About the toolbar: 

○ The Create Fragment button in the toolbar was useful and straightforward. 

○ A plus sign on the corner of the tools would help recognize they are addition 

tools. 

○ Using hover text was suggested. 

○ Putting text on the image of the button itself was deemed excessive. 

● Finally, using the word “Description” for the description field of elements, especially 

Fragments, suggests sketching the events that happen. Calling the field “Context” on the 

other hand suggests writing a more elaborate or complete script. 

● Many of the “Save” buttons in editing contexts made the subject assume the window 

would close after clicking on them. 

 

11.3. Prototype experiment, initial text 
 

En nuestra aventura, el héroe necesita entrar en el castillo para destronar al falso rey que se ha 

apoderado del reino. Nuestro héroe dispone de una moneda de oro, pero no tiene armas. 

 

Un guardia guarda la puerta del castillo. Está armado y parece enfadado. Nuestro héroe podría 

jurar que oye rugir las tripas del caballero. No parece haber otra medida de seguridad que 

impida a los plebeyos entrar en el castillo. 

 

En el mercado cerca del castillo sólo dos tenderetes están abiertos a estas horas de la noche. 

 

La primera tienda es una panadería con barras de pan ya frías. Parece que una barra vale una 

moneda de oro. 

 

La segunda tienda es una armería al aire libre. La calidad de las espadas y hachas parece 
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cuestionable, pero cada arma vale solo dos monedas de oro. 

 

Escondido en un rincón hay un pobre pidiendo con su sombrero. El héroe ve una sola moneda 

de oro en su sombrero. 

 

A rough translation in English would be: 

 

In our adventure, the hero needs to sneak into the castle to overthrow the false king, who has 

taken control of the kingdom. Our hero has a gold coin, but no weapons. 
 

A guardian patrols the castle‟s door. He‟s armed and angry. The hero could swear he hears the 

guard‟s stomach rumble. Other than him, no other security measures are in sight to stop the 

peasants from entering. 
 

Only two shops are left open in the castle market. 
 

The first shop is a bakery, the bread loafs of which are already cold. It seems one loaf is worth 

a gold coin. 
 

The second shop is a weapons shop. The quality of the swords and axes seems questionable, 

but any weapon costs only two gold coins. 
 

Hidden in a corner, a beggar is asking for alms. A lonely gold piece can be seen in the beggar‟s 

hat. 
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11.4. Prototype experiments, full time measurements 
 

Experiment #1: 

 

Reading From 0'37" 6'23" 6'43" 9'18" 11'13" 15'55" 28'43" 

              

 

To 1'09" 6'27" 8'07" 9'38" 11'28" 15'58" 28'50" TOTAL              

 

Duration 

(s) 32 4 144 20 15 3 7 225              

   
                    

Learning 

GUI From 3'55" 5'12"                    

 

To 5'04" 5'34" TOTAL                   

 

Duration 

(s) 69 22 91                   

 
                      

Creating 

Fragments From 3'58" 4'38" 17'42" 30'13" 30'29" 32'00"                

 

To 4'04" 4'40" 17'44" 30'15" 30'31" 32'02" TOTAL               

 

Duration 

(s) 6 2 2 2 2 2 16               

  
                     

Creating 

Relations From 4'42" 22'27" 28'17" 30'47" 30'52" 31'08" 31'09" 32'46" 34'53" 35'00" 35'22" 35'48" 38'32"         

 

To 4'45" 22'31" 28'21" 30'48" 31'02" 31'11" 31'10" 32'52" 34'56" 35'05" 35'44" 36'00" 38'34" TOTAL        

 

Duration 

(s) 3 4 4 1 10 3 1 6 3 5 22 12 2 76        

  
                     

Creating 

Characters From 14'15" 14'29" 15'00" 15'47" ...15'58"                 

 

To 14'27" 14'47" 15'43" 15'55"... 16'56" TOTAL                
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Duration 

(s) 12 18 43 8 58 139                

  
                     

Creating 

Places From 8'07" 9'45" 10'30"                   

 

To 9'15" 10'10" 11'05" TOTAL                  

 

Duration 

(s) 68 25 35 128                  

 
                      

Editing 

Fragments From 4'23" 5'20" ...5'34" ...6'28" ...7'38" 11'29" ...11'48" 18'41" 20'47" 25'43" 27'00" 28'57" 31'38" 33'14" 34'29" 34'50" 37'16" 39'03" ...40'50" 42'03"  

 

To 4'32" 5'28"... 6'15"... 7'24"... 7'43" 11'44"... 12'11" 20'30" 21'06" 26'43" 27'56" 30'08" 31'57" 34'15" 34'44" 34'52" 38'10" 40'44"... 41'03" 43'41" TOTAL 

 

Duration 

(s) 9 8 41 56 5 15 23 109 19 60 56 11 19 61 15 2 54 101 13 98 775 

  
      

 
              

Editing 

Relations From 5'01" ...5'14" 24'31" 28'23" 31'15" 32'13" 32'54" 38'39"              

 

To 5'07"... 5'15" 24'46" 28'39" 31'23" 32'21" 33'10" 38'57" TOTAL             

 

Duration 

(s) 6 1 15 16 8 8 16 18 88             

  
                     

Editing 

Characters From                      

 

To TOTAL                     

 

Duration 

(s) 0                     

  
                     

Editing 

Places From 

 

                    

 

To TOTAL                     

 

Duration 

(s) 0                     
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TOTAL (s) 1611                      

Table 10. Prototype experiments first tester extended time measurements  
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       Experiment #2: 

 

Reading From 00'39" 13'39" 

                 

 

To 01'24" 13'52" TOTAL 

     
           

 

Duration (s) 45 13 58 

    
            

   
                  

Learning GUI From 04'38" 06'55" 11'33" 12'16"                

 

To 06'27" 07'25" 11'44" 12'30" TOTAL               

 

Duration (s) 109 30 11 14 164               

 
                    

Creating Fragments From 04'39" 06'27" 06'31" 10'09" 13'01" 13'05" 18'12" 19'47"            

 

To 04'47" 06'30" 06'33" 10'11" 13'04" 13'07" 18'15" 19'49" TOTAL           

 

Duration (s) 8 3 2 2 3 2 3 2 25           

  
                   

Creating Relations From 06'24" 06'35" 06'47" 06'49" 10'16" 13'09" 13'12" 18'16" 18'21" 19'50" 

   
      

 

To 06'27" 06'40" 06'48" 06'52" 10'18" 13'11" 13'15" 18'19" 18'27" 19'54" TOTAL 

   
     

 

Duration (s) 3 5 1 3 2 2 3 3 6 4 32 

  
      

  
                   

Creating Characters From 

     
              

 

To TOTAL 

     
             

 

Duration (s) 0 

    
              

  
                   

Creating Places From 

   
                

 

To TOTAL 
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Duration (s) 0 

  
                

 
                    

Editing Fragments From 04'57" 06'02" 07'30" 08'12" 09'35" 09'40" 10'03" 10'21" 11'26" 11'34" 13'21" 13'56" 15'29" 16'45" 18'35" 19'27" 19'39" 19'56"  

 

To 05'57" 06'09" 08'09" 09'21" 09'36" 09'43" 10'06" 11'22" 11'29" 11'43" 13'25" 15'16" 16'40" 16'56" 19'24" 19'31" 19'45" 21'23" TOTAL 

 

Duration (s) 60 7 39 69 1 3 3 61 3 9 4 80 71 11 49 4 14 87 575 

  
      

 
            

Editing Relations From 06'55" 07'16 09'26" 12'07" 12'17" 17'33" 17'59" 18'30" 21'37"           

 

To 07'24" 07'24 09'29" 12'11" 12'20" 17'56" 18'04" 18'33" 21'42" TOTAL          

 

Duration (s) 29 8 3 4 3 23 5 3 5 83          

  
                   

Editing Characters From                    

 

To TOTAL                   

 

Duration (s) 0                   

  
                   

Editing Places From 

 
                  

 

To TOTAL                   

 

Duration (s) 0                   

 
                    

TOTAL (s) 991                    

Table 11. Prototype experiments second tester extended time measurements 

  



80 
 

Experiment #3: 

 

Reading From 00'02" 

                    

 

To 02'10" TOTAL 

      
             

 

Duration (s) 128 128 

      
             

   
                    

Learning GUI From 11'46" 11'59" 12'27" 16'05" 16'36" 16'58" 17'01" 17'42" 17'45"             

 

To 11'52" 12'26" 12'30" 16'17" 16'45" 17'00" 17'30" 17'44" 17'55" TOTAL            

 

Duration (s) 6 27 3 12 9 2 29 2 10 100            

 
                      

Creating Fragments From 11'50" 17'30" 19'39" 22'36" 24'47" 26'47" 28'26" 28'29" 33'33" 34'59" 37'46" 39'08" 40'09" 41'21" 42'17"       

 

To 11'56" 17'33" 19'44" 22'38" 24'41" 26'51" 28'28" 29'32" 33'54" 35'03" 37'48" 39'13" 40'12" 41'25" 42'19" TOTAL      

 

Duration (s) 6 3 5 2 4 4 2 3 21 4 2 5 3 4 2 70      

  
                     

Creating Relations From 17'18" ...17'38" 19'48" 23'11" 24'43" 25'18" 26'54" 28'33" 28'36" 33'55" 35'05" 37'49" 39'38" 40'45" 41'58" 42'35"      

 

To 17'21"... 17'41" 19'51" 23'16" 24'46" 25'20" 26'57" 28'35" 28'39" 33'58" 35'09" 37'52" 39'41" 40'47" 42'02" 42'38" TOTAL     

 

Duration (s) 3 3 3 5 3 2 3 2 3 3 4 3 3 2 4 3 49     

  
                     

Creating Characters From 

     
                

 

To TOTAL 

     
               

 

Duration (s) 0 

    
                

  
                     

Creating Places From 

   
                  

 

To TOTAL 

   
                 



81 
 

 

Duration (s) 0 

  
                  

 
                      

Editing Fragments From 12'26" 18'30" 19'56" 22'41" 23'54" 25'53" 27'17" 29'52" 30'44" 34'22" 35'44" 38'21" 39'16" 39'23" 40'16" 40'23" 41'10" 41'27" 42'22" 42'54"  

 

To 17'00" 19'14" 21'56" 23'06" 24'36" 26'49" 28'10" 30'35" 33'28" 34'45" 37'28" 38'45" 39'20" 39'32" 40'20" 40'32" 41'19" 41'40" 42'33" 43'32" TOTAL 

 

Duration (s) 274 44 120 25 42 56 53 37 164 33 164 24 4 9 4 9 9 13 11 38 1133 

  
      

 
              

Editing Relations From 17'44" 19'20" 22'03" 23'31" 25'23" 26'59" 28'43" 29'21" 34'01" 35'15" 38'01" 39'43" 40'39" 40'50" 41'51" 42'04" 42'40"     

 

To 18'15" 19'25" 22'18" 23'50" 25'49" 27'14" 29'16" 29'45" 34'19" 35'40" 38'11" 39'57" 40'43" 40'56" 41'57" 42'09" 42'51" TOTAL    

 

Duration (s) 21 5 15 19 26 15 33 24 18 25 10 14 4 6 6 5 11 257    

  
                     

Editing Characters From                      

 

To TOTAL                     

 

Duration (s) 0                     

  
                     

Editing Places From 

 
                    

 

To TOTAL                     

 

Duration (s) 0                     

 
                      

TOTAL (s) 1997                      

Table 12. Prototype experiments third tester extended time measurements  
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11.5. Prototype experiments, full interviews 
 

Experiment #1: 

 

● General: 

○ Usage of Fragments and Relations was quickly understood after a brief training. 

○ Tooltip is only used when Tester was comfortable using the tool. The first nature 

was to double click the elements to edit them. 

○ How to drag Fragments around the canvas was quickly discovered. 

○ Tester called Fragments Nodes, and Relations, Actions. 

○ Tester suggested some sort of method to check semantic consistency along the 

story would help. 

○ Tester explained creating and planning a story in pen and paper is still the 

preferred method, even if it‟s less agile. However this tool has better scaling and 

is good at organizing the story and “cleaning” it, which is still relevant and useful. 

● Fragment creation: 

○ The colors were used to mark bad endings (as red). 

○ The physical “Add Fragment” button was dragged into the canvas, desiring to 

create a new fragment (unsuccessfully). 

○ The tester was explained how the Fragments would change size automatically 

depending on the amount of information inside them; still, they expressed 

preference in being able to decide the size of Fragments themselves. 

○ The subject liked the extensive color palette, but would like a more restricted 

number of colors added there as well, so that two fragments can easily have the 

same color (aesthetically pleasing). 

● Relation creation: 

○ Instead of clicking the origin Fragment and then the end Fragment, tester 

originally tried to drag from one to the other. 

○ The tester had no use for the Conditions of Relations, and did not understand what 

they were for either, so they were left empty. 

○ Tester suggested changing the structure of a Relation to Name and Content, 

similar to how Fragments are structured. 

● Character/Place creation: 

○ The first instinct was to add Characters and Places on the search bars found in the 

Fragment edition window. When that did not work, the tester thought the creator 

should be someplace else in the interface. They looked at the File menu before 

finally finding the button inside the Edit menu. 

○ Once at the window, subject immediately filled the empty spaces and then clicked 

create, in order to create the first Character. 

○ The small Add button below the Character list was thought to also collect the 
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information on the fields and create a new Character out of it. It wasn‟t 

programmed to do that. 

○ The fact that the Character / Place titles acted as tabs was not straightforward. 

○ The tester suggested tags could also be added to Characters and Places to further 

classify and identify them. 

 

Experiment #2: 

 

● General: 

○ Usage of Fragments and Relations was easily understood after a brief training. 

○ Deleting of elements was done without problems. 

○ Tester suggested a small pop up window could appear when hovering over an 

element, giving bits of information about the element. 

○ The suggested the windows needn‟t be fixed; they could be moved around and 

resized. The edit window could also appear next to the element being edited. 

○ Subject believed the tool could work both as an organizer and creator of stories. It 

solved the problem of pen and paper of having to redraw a good part of the story 

if something needed to be corrected. 

● Fragment: 

○ Tester believed Character and Places‟ search bars in the Fragment editing window 

are places to list Characters and Places related to the fragment. 

○ Tester thinks the creating process of creating and editing Fragments and Relations 

is repetitive, but relatively quick. 

○ They suggested that to further classify the Fragments, they could have various 

forms, like a star or rectangle, other than a circumference. 

○ Subject is partial to adding a more restrictive palette to the Fragment color 

picking, to have two or more identically-colored Fragments. 

○ They used coloring in Fragments to discriminate the story into a series of plot 

threads which were different from the others. 

○ Subject could enjoy a richer text formatting when writing the Fragment‟s content. 

○ The tester said the size of the Fragments (and also the text inside of them) should 

be defined manually by the user. 

● Relation: 

○ Tester suggested Fragment‟s dragging could have a snapping effect added to 

them, so that some Relations that included them could have aesthetically pleasant 

degrees (0º, 45º, 90º…) 

○ Instead of clicking the origin Fragment and then the end Fragment, the tester 

originally tried to drag from one to the other. 

○ Subject did not fill the Action in some Relations, because they thought the 

decisions were, semantically, straightforward. However, they still understood the 

Relations mechanics. 
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○ The tester had no use for the Conditions of Relations, and did not understand what 

they were for either, so they were left empty. 

○ Tester suggested the option to customize the Relations appearance; specifically, 

the arrow head and the arrow line. 

● Character/Place creation: 

○ Tester did not find the Character/Place creation menu. However they understood 

the concept and helpfulness of associated data to discriminate and classify 

Fragments. 

 

Experiment #3: 

● General: 

○ Usage of Fragments and Relations was quickly understood after a brief training. 

○ Tester calls the Relations Actions 

○ This subject used the pen and paper to plan their story‟s first iteration. However 

they expressed that, while planning on paper is better to brainstorm and form the 

first idea, the tool is successful in organizing the story in a single place, with 

better scaling; also, the tool‟s ability to correct and polish Elements of the story 

was said to be superior to its manual counterpart. 

○ Subject did not realize the canvas could be dragged around. 

○ Tester tried to copy and paste a Fragment into the canvas with Ctrl+C and Ctrl+V. 

They also suggested having a feature to copy multiple elements of the diagram. 

○ Tester said being able to print the story in a linear format (paper) could be 

beneficial since the story could be read without digital support. 

○ The tester believed the creating process and was laborious. The repetitive inertia 

in filling information wasn‟t necessarily be bad, but maybe there were too many 

steps in each iteration (when creating various elements at once, closing an edit 

window to open another one, etc.) 

● Fragment creation: 

○ Tester believed Character and Places‟ search bars in the Fragment editing window 

are places to list Characters and Places related to the fragment. 

○ Tester did not know how to use the contextual menu. 

○ Tester was used to double click on visual elements they wanted to edit. Since that 

did not work they tried to right-click on the element. Finally they looked for a 

button in the Edit menu. 

○ Tester tried to drag the Add Fragment button directly to the canvas 

(unsuccessfully). 

● Relation creation: 

○ The tester had no use for the Conditions of Relations, and did not understand what 

they were for either, so they were left empty. 

○ The tester tried to drag the Add Relation button directly to the origin Fragment on 

the canvas. 
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○ The tester made an effort to drag the Fragments around so that the text of the 

Relations could be fully seen. They suggested that the displayed text were only a 

fragment of the whole Action field, followed by ellipsis. 

○ In addition, tester suggested clicking the text of a Relation should also select the 

Relation. 

● Character/Place creation:  

○ Tester did not find the Character/Place creation menu. 

○ However they understand the concept and helpfulness of associated data to 

discriminate and classify Fragments. 


